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1关于本手册 

1.1 手册内容 

本手册主要介绍高云半导体GW1N(R)和GW2A(R)系列FPGA产品编程

配置方面的通用特性及功能，与每个系列的 FPGA 产品编程配置手册配合使

用，旨在帮助用户更好地使用 Gowin FPGA 产品。高云半导体 FPGA 产品

名称是否包含 R 不影响器件的配置特性。 

1.2 适用产品 

本手册中描述的信息适用于所有高云半导体 FPGA 产品。 

1.3 相关文档 

通过登录高云半导体网站 http://www.gowinsemi.com.cn 可以下载、查

看以下相关文档： 

 GW1N(R)系列 FPGA 产品编程配置手册 

 GW2A(R)系列 FPGA 产品编程配置手册 

http://www.gowinsemi.com.cn/
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1.4 术语、缩略语 

表 1-1 中列出了本手册中出现的相关术语、缩略语及相关释义。 
表 1-1 术语、缩略语 

术语、缩略语 全称 含义 

LUT Look-up Table 查找表 

FPGA Field Programmable Gate Array 现场可编程门阵列 

JTAG Joint Test Action Group 联合测试行动组 

GPIO General Purpose Input Output 通用输入、输出接口 

SPI Serial Peripheral Interface 串行外设接口 

SRAM Static Random Access Memory 静态随机存储器 

MSPI Master Serial Peripheral Interface 主串行外设接口 

IEEE 
Institute of Electrical and Electronics 
Engineers 

电气和电子工程师协会 

ID Identification 身份标识号 

CRC Cyclic Redundancy Check 循环冗余校验 

 

1.5 技术支持与反馈 

高云半导体提供全方位技术支持，在使用过程中如有任何疑问或建议，

可直接与公司联系： 

网址：http://www.gowinsemi.com.cn 

E-mail：support@gowinsemi.com 

Tel：+86 755 8262 0391 

http://www.gowinsemi.com.cn/
file:///C:/Users/Yanan/AppData/Roaming/Microsoft/Word/support@gowinsemi.com
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2名词解释 

本章主要介绍高云半导体FPGA产品编程配置过程中常用的一些名词及

含义，帮助用户熟悉高云半导体 FPGA 产品编程配置相关的概念。 

表 2-1 名词解释 

名词 释义 

编程（Program） 

将 Gowin 云源软件生成的比特流数据写入到 FPGA

内置 Flash 或者与 FPGA 相连的外部 SPI Flash 的

过程。 

配置（Configure） 

将 Gowin 云源软件生成的比特流数据通过外部接口

或内置 Flash 加载到 FPGA 的 SRAM 存储区的过

程。 

GowinCONFIG 

除通用的 JTAG 配置模式外，高云半导体 FPGA 产

品支持的其他配置方式，包括自启动配置，双启动

配置，MSPI 配置，SSPI 配置，SERIAL 配置，CPU

配置。每款器件支持的 GowinCONFIG 配置模式多

少取决于器件型号和封装类型。 

自启动配置（AUTO 

BOOT） 

FPGA 从内置 Flash 读取比特流数据进行配置的过

程。只有非易失器件支持此模式。 

双启动配置（DUAL 

BOOT） 

FPGA 从内置 Flash 或外部 Flash 读取比特流数据

进行配置的过程，2 个比特流文件分别存放在内置

Flash 和外部 Flash，当首选的 Flash 配置失败时切

换到备选 Flash 进行配置。只有非易失器件支持此

模式。 

MSPI 配置 
FPGA 作为主器件（master），通过 SPI 接口主动从

外部 Flash 读取比特流数据进行配置的过程。 

SSPI 配置 
FPGA 作为从器件（slave），外部主机（master）

通过 SPI 接口写入比特流数据进行配置的过程。 

SERIAL 配置 
FPGA 作为从器件（slave），外部主机（master）

通过串行接口写入比特流数据进行配置的过程。 

CPU 配置 
FPGA 作为从器件（slave），外部主机（master）

通过并行接口（数据位宽 8-bit）写入比特流数据进
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名词 释义 

行配置的过程。 

多重配置（MULTI 

BOOT） 

MSPI 配置模式的衍生概念，是指 FPGA 从外部

Flash 的不同地址读取比特流数据进行配置的过程。

用户在前一个比特流数据中写入后一次配置的比特

流数据的加载地址，在器件不掉电的情况下通过触

发 RECONFIG_N 切换数据流文件完成配置。支持

MSPI 配置模式的 FPGA 产品均支持此模式。 

远程升级 

用户的一种应用场景，即在 FPGA 启动工作后，若

有升级需求，先通过远程操作将比特流数据写入到

外部 Flash 中，通过触发 RECONFIG_N 或重新上

电使 FPGA 读取外部 Flash 完成配置的过程。 

菊花链 

FPGA 器件以串行的方式依次连接起来的一种方

式，可以从链首按照连接顺序依次对器件进行配置，

只有相邻的器件之间才能传输数据。 

用户模式（User 

Mode） 

FPGA 完成一次配置操作后，将控制权移交给用户

的行为，在此模式下用户可根据需要完成自身的功

能。 

ID CODE 
高云半导体 FPGA 器件的身份标识，每一个系列的

器件具有独立的编号。 

USER CODE 

用户为自己所使用的 FPGA 器件进行的身份标识，

可以通过 Gowin 编程软件写入到器件中，最高可支

持 32-bit。 

安全位（Security Bit） 

高云半导体为保护 FPGA 产品配置数据的安全性所

做的特殊设计。用户将设置了安全位的比特流数据

写入器件后，任何人都将无法进行数据回读操作。

云源软件默认为所有 FPGA 产品的比特流数据设置

了安全位。 

加密（Encryption） 

GW2A(R)系列 FPGA 产品支持的特性，加密的比特

流数据写入 FPGA 后，器件自行与事先存储的密钥

匹配，匹配成功后进行解密并唤醒器件；匹配失败

后器件无法工作。 
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3配置管脚介绍 

高云半导体 FPGA 产品配置模式多样，包括通用型的 JTAG 配置、主动

配置、被动配置、串行配置和并行配置等，可以满足用户不同外设环境下的

各种需求。编程配置相关的管脚既能够完成配置功能，又可以设置为普通的

I/O，用户可根据实际使用情况进行选择。用户也可以根据配置管脚的功能对

其灵活控制，满足一些特殊需求。 

3.1 配置管脚列表及复用选项 

3.1.1 配置管脚列表 
高云半导体 FPGA 产品所有与配置相关的管脚如表 3-1 所示，表中也标

注了每种配置模式使用到的管脚及芯片封装过程中的管脚共用情况。 
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表 3-1 配置管脚列表 

管脚名称 I/O 类型 JTAG 

GowinCONFIG 

AUTO 
BOOT 

SSPI MSPI 
DUAL 
BOOT 

SERIAL CPU 

RECONFIG_N I √ √ √ √ √ √ √ 

JTAGSEL_N I √       

TDO O √       

TMS I √       

TCK I √       

TDI I √       

READY I/O √ √ √ √ √ √ √ 

DONE I/O √ √ √ √ √ √ √ 

MODE[2:0] I  √ √ √ √ √ √ 

SCLK I   √   √ √ 

CLKHOLD_N/DIN I   √   √ √ 

WE_N/DOUT O      √ √ 

MI/D7 I/O    √   √ 

MO/D6 I/O    √   √ 

MCS_N/D5 I/O    √   √ 

MCLK/D4 I/O    √   √ 

FASTRD_N/D3 I/O    √   √ 

SI/D2 I/O   √    √ 

SO/D1 I/O   √    √ 

SSPI_CS_N/D0 I/O   √    √ 

注！ 

 不同型号和封装的器件支持的配置模式不同，关于不同器件支持的配置模式请参考

GW1N(R)系列 FPGA 产品编程配置手册/GW2A(R)系列 FPGA 产品编程配置手册； 

 关于不同配置模式下各管脚的定义请参考 5 配置模式介绍； 
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3.1.2 配置管脚复用 
为最大化地提高 I/O 的利用率，高云半导体的 FPGA 产品支持将配置管

脚设置为普通 I/O 使用。所有系列的 FPGA 上电后进行任何配置操作前，与

配置相关的管脚均默认作为配置管脚使用。配置成功后，器件进入用户模式，

按照用户选择的复用选项重新分配管脚的功能。 

注！ 

用户设置管脚复用选项时，需确保管脚的外部初始连接状态不影响器件的配置过程。对于影

响配置的连接，需要先进行隔离处理，等待 FPGA 进入用户模式后再进行修改。 

配置管脚复用选项如表 3-2 所示。 
表 3-2 配置管脚复用选项 

设置名称 设置选项 说明 

JTAG PORT 

NON-RECOVERY 
TMS，TCK，TDI，TDO 作为专用配置管脚，

JTAGSEL_N 作为 GPIO。 

RECOVERY 

JTAGSEL_N 作为专用配置管脚： 

 JTAGSEL_N=0，TMS,TCK,TDI,TDO 作

为配置管脚； 

 JTAGSEL_N=1，TMS,TCK,TDI,TDO 在

配置结束后作为 GPIO。 

SSPI PORT 

NON-RECOVERY 
SCLK，CLKHOLD_N，SSPI_CS_N，SI 和

SO 作为专用配置管脚。 

RECOVERY 
SCLK，CLKHOLD_N，SSPI_CS_N，SI 和

SO 在配置结束后作为 GPIO。 

MSPI PORT 

NON-RECOVERY 
FASTRD_N，MCLK，MCS_N，MO 和 MI

作为专用配置管脚。 

RECOVERY 
FASTRD_N，MCLK，MCS_N，MO 和 MI

在配置结束后作为 GPIO。 

RECONFIG_N 
NON-RECOVERY 专用配置管脚。 

RECOVERY 配置结束后作为 GPIO。 

READY 
NON-RECOVERY 专用配置管脚。 

RECOVERY 配置结束后作为 GPIO。 

DONE 
NON-RECOVERY 专用配置管脚。 

RECOVERY 配置结束后作为 GPIO。 

注！ 

 [1]对于 JTAGSEL_N 未封装出来的器件，用户在调试 JTAG 管脚复用的案例时，建议

上电前将 MODE 值设置为非自动配置的模式（即非自启动、双启动和 MSPI 模式）避

免其他比特流数据影响配置过程，用户上电后手动进行 JTAG 配置后，器件进入用户模

式，JTAG 管脚变为 GPIO； 

 [2]SERIAL 和CPU配置模式的管脚由于与其他配置模式共用，无法单独设置为GPIO，

但是当这些管脚工作在非共用配置模式时可以设置为 GPIO。 
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通过 Gowin 云源软件配置管脚复用： 

1. 打开 Gowin 云源软件中相应的工程； 

2. 在菜单栏中选择“Project>Configuration>Dual-Purpose Pin”，如图 3-1

所示； 

3. 勾选对应选项设置配置管脚的复用情况。 
图 3-1 配置管脚复用设置 

 
 

3.2 配置管脚功能及应用 

RECONFIG_N、READY 和 DONE 管脚是每种模式都会用到的管脚。

其他配置管脚可根据具体应用设置为配置专用管脚或用户管脚。 

表 3-3 管脚功能 

管脚名称 功能描述 

RECONFIG_N 

作为配置管脚时，类型为输入，具有内部弱上拉。

低电平有效，相当于 FPGA 编程配置的复位功能，

RECONFIG_N 拉低时 FPGA 无法进行任何方式的

配置操作。 

作为配置管脚时，需要一个脉冲宽度不少于 25ns

的低电平启动 GowinCONFIG 配置模式，使器件按

照 MODE 设置值重新加载比特流数据。用户也可以

通过编写逻辑控制此管脚，从而按照自身需求触发

器件进行重新配置；作为 GPIO 时，只能用作 output

类型。为保障配置过程顺利进行，用户复用

RECONFIG_N 管脚时需将其初始值置为高电平。 
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管脚名称 功能描述 

READY 

inout 类型管脚。高电平有效，只有 READY 拉高时

FPGA 才能进行配置操作，READY 信号拉低后需采

用器件上电或触发 RECONFIG_N 的方式恢复状

态。 

作为配置管脚时，若为 output 类型，可以指示 FPGA

当前能否进行配置：当器件具备配置条件时，

READY 信号为高电平；若配置失败，则 READY 信

号变为低电平。若为 input 类型，用户可通过自身逻

辑或在器件外部人为拉低 READY 信号以延迟配置

过程。作为 GPIO 时，可用作 input 或 output 类型。

READY用作 input类型的GPIO时需保证配置开始

前其初始值为 1，否则 FPGA 无法进行配置。 

DONE 

inout 类型管脚。FPGA 配置成功的标志信号，配置

成功后 DONE 信号拉高。 

作为配置管脚时，若为 output 类型，可以指示 FPGA

当前配置过程是否成功：当配置成功时，DONE 信

号为高电平，器件进入工作状态；配置过程未完成

或配置失败时，DONE 信号保持低电平状态。若为

input 类型，用户可通过自身逻辑或在器件外部人为

拉低 DONE 信号以延迟其进入用户模式。

RECONFIG_N 或 READY 保持低电平状态时，

DONE 信号也会保持在低电平状态。使用 JTAG 电

路配置 SRAM 的过程中，DONE 信号的值没有参考

意义。作为 GPIO 时，可用作 input 或 output 类型。

DONE 用作 input 类型的 GPIO 时需保证配置开始

前其初始值为 1，否则配置结束后 FPGA 无法进入

用户模式。 

MODE 

作为配置管脚时，类型为输入，内部弱上拉，最多

可达 3-bit 位宽，GowinCONFIG 配置模式选择信号。

FPGA 上电或低电平脉冲触发 RECONFIG_N 时，

器件根据 MODE 值进入相应的 GowinCONFIG 状

态，高云半导体每个系列的 FPGA 产品 MODE 值对

应的配置模式略有不同，具体请参考相应器件的编

程配置手册。由于每个封装类型的管脚数目不同，

有些器件的 MODE 管脚未完全封装出来，未封装出

来的 MODE 管脚在器件内部已接地，具体请参考相

应器件的 PINOUT 手册。MODE 管脚作为 GPIO 时，

只能用作 output 类型。 

JTAGSEL_N 

作为配置管脚时，类型为输入，内部弱上拉。如果

在云源软件中设置了 JTAG 管脚复用为 GPIO，则器

件上电后进行一次成功的配置后 JTAG 管脚变为

GPIO，JTAG 配置功能失效，用户可通过拉低

JTAGSEL_N 进行恢复；如果用户未设置 JTAG 管
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管脚名称 功能描述 

脚复用，则 JTAG 配置功能一直可用。作为 GPIO

时，可用作 input 或 output 类型。 

注！ 
JTAGSEL_N 管脚与 JTAG 配置的 4 个管脚（TCK、TMS、

TDI、TDO）设置为 GPIO 时存在互斥关系：JTAGSEL_N

设置为 GPIO 时，JTAG 管脚只能作为配置管脚；JTAG 管

脚设置为 GPIO 时，JTAGSEL_N 只能作为配置管脚。 

TCK 

作为配置管脚时，类型为输入。 

JTAG 配置模式的串行时钟输入管脚。作为 GPIO

时，可用作 input 或 output 类型。 

TMS 

作为配置管脚时，类型为输入，内部弱上拉。 

JTAG 配置模式的串行模式输入管脚。作为 GPIO

时，可用作 input 或 output 类型。 

TDI 

作为配置管脚时，类型为输入，内部弱上拉。 

JTAG 配置模式的串行数据输入管脚。作为 GPIO

时，可用作 input 或 output 类型。 

TDO 

作为配置管脚时，类型为输出。 

JTAG 配置模式的串行数据输出管脚。作为 GPIO

时，可用作 input 或 output 类型。 

SCLK 

作为配置管脚时，类型为输入。 

SSPI、SERIAL 和 CPU 配置模式的时钟输入管脚。

作为 GPIO 时，可用作 input 或 output 类型。 

CLKHOLD_N 

作为配置管脚时，类型为输入，内部弱上拉。 

SSPI 和 CPU 配置模式的时钟锁定管脚：当输入高

电平时，SCLK 对应的操作有效；当输入低电平时，

SCLK 对应的操作无效。作为 GPIO 时，可用作 input

或 output 类型。 

SSPI_CS_N 

作为配置管脚时，类型为输入，内部弱上拉。SSPI

配置模式的片选信号，低电平有效。作为 GPIO 时，

可用作 input 或 output 类型。 

SI 

作为配置管脚时，类型为输入。SSPI 配置模式的串

行数据输入管脚。作为 GPIO 时，可用作 input 或

output 类型。 

SO 

作为配置管脚时，类型为输出。SSPI 配置模式的串

行数据输出管脚。作为 GPIO 时，可用作 input 或

output 类型。 

MCLK 

作为配置管脚时，类型为输出。 

MSPI 配置模式的输出时钟管脚，来源于 FPGA 内

部晶振，晶振的输出频率范围从 2.5MHz~125MHz，

默认输出频率为 2.5MHz，MSPI 配置模式不支持

125MHz 时钟。关于片内晶振的详细数据请参考相

应器件的数据手册。 

用户可通过云源软件界面修改 MCLK 的频率值，如

图 3-2 所示：打开云源软件工程，在菜单栏中选择
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管脚名称 功能描述 

“Project>Configuration”，单击“BitStream”页签，

在“Download Speed”下拉列表中选择 MCLK 的

频率值。作为 GPIO 时，可用作 input 或 output 类

型。 

MCS_N 

作为配置管脚时，类型为输出。 

MSPI配置模式的片选信号，低电平有效。作为GPIO

时，可用作 input 或 output 类型。 

MI 

作为配置管脚时，类型为输入。 

MSPI 配置模式的串行数据输入管脚。作为 GPIO

时，可用作 input 或 output 类型。 

MO 

作为配置管脚时，类型为输出。 

MSPI 配置模式的串行数据输出管脚。作为 GPIO

时，可用作 input 或 output 类型。 

FASTRD_N 

作为配置管脚时，类型为输入。 

MSPI 配置模式读取 SPI Flash 速度选择信号：当

FASTRD_N 为高电平时为普通读取模式（指令

0x03）；当FASTRD_N为低电平时为高速读取模式，

各个厂家的 Flash 高速读取操作指令不同，具体请

参考相应 Flash 的数据手册。作为 GPIO 时，可用

作 input 或 output 类型。 

WE_N 

作为配置管脚时，类型为输入。 

CPU 配置模式的读写使能信号选择管脚：当 WE_N

为高电平时表示读操作；当 WE_N 为低电平时表示

写操作。作为 GPIO 时，可用作 input 或 output 类

型。 

D0~D7 

inout 类型管脚。 

CPU 配置模式的数据输入输出管脚，8-bit 位宽。根

据 WE_N 的值确定 D0~D7 的输入输出方向。作为

GPIO 时，可用作 input 或 output 类型。 

DIN 

作为配置管脚时，类型为输入，内部弱上拉。 

SERIAL 配置模式的串行数据输入管脚。作为 GPIO

时，可用作 input 或 output 类型。 

DOUT 

作为配置管脚时，类型为输出。 

SERIAL 配置模式的串行数据输出管脚，只在 FPGA

级联时用作后一个器件的输入。作为 GPIO 时，可

用作 input 或 output 类型。 
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图 3-2 MCLK 频率设置 
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4比特流文件 

高云半导体为保障配置数据的安全准确传输，在 FPGA 产品的比特流文

件中默认加入了 CRC 校验算法并设置了安全位。数据配置过程中实时校验

输入数据是否出错，错误的数据无法唤醒器件，DONE 信号拉低。设置了安

全位的比特流数据完成配置后，任何用户无法进行回读操作。 

4.1 配置数据加密 

高云半导体 GW2A(R)系列 FPGA 产品支持比特流数据加密，采用

128-bit的AES加密算法。用户在Gowin云源软件界面输入加密密钥（KEY），

软件会根据用户密钥生成加密的比特流数据，加密的比特流数据加载到器件

后，FPGA 会根据事先存入的解密密钥值进行配置数据解析，解析成功后完

成配置过程，解析失败后 READY 和 DONE 信号拉低，器件无法正常工作。 

在云源软件中写入加密密钥的方法如下： 

1. 打开云源软件中相应的工程； 

2. 在菜单栏中选择“Project>Configuration”； 

3. 单击“BitStream”页签，勾选“Enable Encryption(only support GW2A)”

并输入密钥值，如图 4-1 所示。 
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图 4-1 加密密钥设置方法 

 
 

加密密钥设置成功后，还需要将解密的密钥写入到FPGA的密钥存储区，

器件才能解析加密的比特流数据完成配置。 

解密密钥的写入方法如下： 

1. 打开 Gowin 编程软件； 

2. 扫描 FPGA 器件； 

3. 右键单击器件选择 Configure Security； 

4. 在弹出的界面上输入之前加密的密钥值并单击“write”将其写入到 FPGA，

如图 4-2 所示。 

图 4-2 解密密钥设置方法 

 
 

解密密钥写入成功后可以选择界面上的读取指令回读写入的密钥进行验
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证。密钥写入成功后，用户也可选择 lock命令将密钥“锁死”在FPGA内部，

之后任何对密钥的读取和写入操作都将无效：密钥值无法进行修改，读取的

密钥所有位全部为“1”。设置解密密钥后，加密的比特流数据只有与解密密

钥匹配成功后才能唤醒。非加密比特流数据的配置不受密钥影响。 

注！ 

高云半导体 FPGA 的密钥初始值所有位全部为 0，当把密钥值的某一位修改为 1 后便无法改

回0。例如，用户的某次操作中写入的密钥值为 00000000-00000000-00000000-00000001，

之后修改此器件的密钥时最低位也必须是 1。 



4 比特流文件 4.2 配置文件大小 

 

UG290-1.02 16(34) 

 

4.2 配置文件大小 

高云半导体 FPGA 产品配置数据目前仅支持二进制格式，由云源软件生

成的后缀名为.fs 的文件是文本格式，用户可以使用编程软件中的转换工具将

其转化为二进制格式： 

1. 打开 Gowin 编程软件； 

2. 单击菜单栏“Tools>File Converter”打开格式转换工具； 

3. 双击相关“File”选择需要转换的文件并选择保存路径，单击右下角

“Convert”按钮进行转换，如图 4-3 所示。 
图 4-3 比特流格式转换工具 

 
 

高云半导体支持比特流数据的压缩，压缩比例与用户的设计相关，本文

档只提供未压缩的配置文件大小，如表 4-1 所示。 

表 4-1 高云半导体 FPGA 产品配置文件大小 

器件名称 配置文件大小（不含 EBR） 配置文件大小（含 EBR） 

GW1N-1 42 KBytes 82 KBytes 

GW1N-4 142 KBytes 216 KBytes 

GW1NR-4 142 KBytes 216 KBytes 

GW2AR-18 563 KBytes 886 KBytes 

GW2A-55 1393 Kbytes 2268 KBytes 

注！ 

 [1]其他产品的配置文件大小在后续版本更新； 

 [2]表中的数据是二进制格式的文件大小，并且配置文件未进行压缩。 
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4.3 配置选项设置 

高云半导体FPGA产品编程配置相关的特性需要结合云源软件进行选项

设置以生成正确的比特流数据。 

设置主要包括配置管脚复用相关的选项和比特流数据生成相关的选项。 

配置管脚复用相关的设置方法请参考 3.1.2 配置管脚复用。 

配置数据相关的设置界面请参考图 4-1，选项包括 CRC 校验使能、比特

流数据压缩、加密密钥设置、安全位设置、MSPI 配置频率选择、多重配置

模式下 SPI Flash 启动地址设置、USER CODE 设置等。SPI Flash 启动地

址低 12 位无效，用户可设置的是 ADDR[23:12]的地址空间。 

注！ 

高云半导体云源软件勾选加密密钥设置选项后强制勾选安全位设置选项，用户使用这样的比

特流数据进行配置，既可以保证数据传输过程的安全，又能够阻止任何回读操作，最大限度

地保障了用户数据的安全性。 
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5配置模式介绍 

高云半导体 FPGA 产品包含基于 SRAM 工艺的 GW2A(R)系列的高性能

器件和嵌入 Flash 的 GW1N(R)系列的小容量非易失器件。基于 SRAM 工艺

的器件掉电后器件内部的配置数据丢失，每次上电后需重新配置；嵌入 Flash

的非易失器件掉电后数据仍然存储在芯片内部，重新上电时可以通过自启动

配置或双启动配置的方式由器件自动进行重新配置。 

高云半导体 FPGA 产品封装类型丰富，每一种封装的器件支持的配置模

式与封装出来的配置管脚数目有关：所有器件均支持通用的 JTAG 配置；只

有非易失器件支持自启动或双启动配置；每种配置模式的 MODE 值各不相同。 

注！ 

关于 GW1N(R)系列及 GW2A(R)系列 FPGA 产品支持的配置模式及上电要求请分别参考

《GW1N(R)系列 FPGA 产品编程配置手册》及《GW2A(R)系列 FPGA 产品编程配置手册》

中 3 编程配置须知。 
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5.1 配置须知 

高云半导体 FPGA 产品目前分为 GW1N(R)和 GW2A(R)两大家族，其中

GW1N(R)家族包含 GW1N-1、GW1N-2、GW1N(R)-4、GW1N(R)-6 和

GW1N(R)-9 系列产品。GW2A(R)家族包含 GW2A(R)-18 和 GW2A-55 两个

系列。器件名称中是否包含 R 不影响配置特性，主要区别是带 R 的 FPGA

内部集成了 SDRAM。 

高云半导体 FPGA 产品按照配置数据的存储和指令的作用位置分为对

SRAM 的操作、对内置 Flash 的操作和对外部 Flash 的操作，其中，对内置

Flash 的操作只有 GW1N(R)系列产品支持，对 SRAM 和外部 Flash 的操作

所有产品均可支持。 

对 SRAM 的操作包括读取器件 ID CODE 和 USER CODE，读取器件状

态寄存器信息以及 SRAM 配置。器件 ID 验证是配置操作的前提，只有 ID 验

证成功的器件才能进行配置；USER CODE 是为方便用户对 ID CODE 相同

的多个器件加以区分进行的编号标识；器件的状态寄存器记录着 FPGA 配置

前后的状态信息，用户可据此分析器件状态，状态寄存器的含义请参考

《Gowin Programmer 用户指南》。SRAM 配置操作时需要注意，只有未设

置安全位的比特流数据支持验证功能。设置了安全位的数据任何用户无法进

行回读验证。 

对内置 Flash 的操作包括擦除、擦除和编程以及擦除、编程和验证操作。

只能通过 JTAG 接口操作内置 Flash，时钟速率限制在 2MHz~2.5MHz。 

注！ 

使用内置 Flash 配置 SRAM 的操作（自启动配置和双启动配置）和内置 Flash 的编程操作

过程中 FPGA 需要保持上电状态并且不能低电平触发 RECONFIG_N，否则可能会对内置

Flash 造成不可修复的破坏。 

内置 Flash 的编程验证在配置 SRAM 操作之前完成，配置结束后设置了

安全位的数据无法回读验证。 

对外部 Flash 的操作包括擦除、编程以及擦除和编程。外部 Flash 操作

前应将 MODE 值设置为“011”状态并使用低电平脉冲触发 RECONFIG_N

或者使 FPGA 重新上电。擦除操作将擦除整片 Flash，使用多重配置的用户

写入多个比特流数据时需要选择不含擦除的编程操作。 

用户在使用不同配置模式时，需要根据配置管脚的作用，确保 FPGA 工

作在已选择的配置模式下。用户端管脚数目不足时，可以通过其他连接方式

灵活处理这些管脚，只保留数据传输相关的管脚即可。MODE[2:0]用来选择

GowinCONFIG 的编程配置模式，用户不需要改变模式时可以使用上拉或下

拉的方式将其固定在特定的模式，上拉电阻推荐 4.7K，下拉电阻推荐 1K。 

注！ 

RECONFIG_N、READY 和 DONE 管脚与每种配置模式相关，无论用户是否将它们设置为

GPIO，都需要保证在配置操作完成前它们的初始值或管脚连接状态满足编程配置条件。 

 

用户进行电路原理图设计时，推荐接法如图 5-1 所示。 
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图 5-1 固定管脚推荐接法 

FPGA

MODE[0]

                       

MODE[1]

MODE[2] 

                            

RECONFIG_N

                                     

                                    

READY DONE

4.7K

LED

DC3.3V4.7KDC3.3V

LED

4.7KDC3.3V

1K

1K

KEY

1K

 

注！ 

 用户需要改变 MODE 值时可增加拨码开关；部分器件 MODE 管脚未完全封装出来，未

封装的 MODE 管脚已内部接地； 

 JTAG 配置过程中 READY 和 DONE 信号的值没有参考意义； 

 RECONFIG_N、READY 和 DONE 未封装出来的管脚已内部处理，不影响配置功能。 
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MODE[2:0]的值与配置模式的对应关系如表 5-1 所示。 

表 5-1 配置模式对应的 MODE 值 

配置模式 GW1N(R) GW2A(R) 

JTAG XXX XXX 

GowinCONFIG 

AUTO 
BOOT 

000 XXX 

SSPI 001 001 
MSPI 010 000 
DUAL 
BOOT 

100/110 XXX 

SERIAL 101 101 
CPU 111 111 

注！ 

JTAG 配置模式与 MODE 值无关，GW2A(R)系列不支持 AUTO BOOT 和 DUAL BOOT。

GW1N(R)系列有两种形式的 DUAL BOOT，GW1N(R)系列所有 FPGA 产品均支持 MODE

值为 100 的 DUAL BOOT 模式，但是只有 GW1N(R)-6 和 GW1N(R)-9 器件支持 MODE 值

为 110 的 DUAL BOOT 模式。 

5.2 JTAG 配置 
注！ 

关于 JTAG 配置时序图及相关时序参数说明请分别参考《GW1N(R)系列 FPGA 产品编程配

置手册》及《GW2A(R)系列 FPGA 产品编程配置手册》中 5 配置模式介绍。 

高云半导体 FPGA 产品的 JTAG 配置模式符合 IEEE1532 标准和

IEEE1149.1 边界扫描标准。 

JTAG 配置模式是将比特流数据写入到高云半导体 FPGA 产品的 SRAM

中，掉电后配置数据丢失。高云半导体所有封装的 FPGA 产品均支持 JTAG

配置模式。JTAG 配置模式的相关管脚如表 5-2 所示。 

表 5-2 JTAG 配置模式管脚定义 

管脚名称 I/O 类型 说明 

JTAGSEL_N
1
 I,内部弱上拉 

将 JTAG 管脚从 GPIO 恢复为配置管脚，低电平

有效 

TCK
2
 I JTAG 串行时钟输入 

TMS
2
 I,内部弱上拉 JTAG 串行模式输入 

TDI I,内部弱上拉 JTAG 串行数据输入 

TDO O JTAG 串行数据输出 

注！ 

 [1] JTAGSEL_N 信号只有当 JTAG 管脚设置为 GPIO 并且器件启动工作后才起作用； 

 [2] TCK 需在 PCB 上连接 4.7K 下拉电阻。 
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JTAG 配置模式器件连接关系如图 5-2 所示。 

图 5-2 JTAG 配置模式连接示意图 

FPGA

JTAGSEL_N

TDI

TCK

TMS

TDO

JTAG PORT

4
.7

K

 

注！ 

 对于 JTAGSEL_N 未封装出来的器件，用户在调试 JTAG 管脚复用的案例时，建议上

电前将 MODE 值设置为非自动配置的模式（自启动、双启动和 MSPI）避免其他比特

流数据影响配置过程，用户上电后手动进行 JTAG 配置后，器件进入用户模式，JTAG

管脚变为 GPIO； 

 JTAG 配置模式时钟频率不能高于 40MHz。 

除了进行常规的 JTAG 配置 SRAM 操作外，高云半导体非易失 FPGA 器

件（GW1N(R)系列）的内置 Flash 和其他所有系列的 FPGA 产品的外部 SPI 

Flash 的编程操作也可通过 JTAG 管脚进行。非易失器件内置 Flash 的编程

操作连线方式与 JTAG 配置模式相同，外部 SPI Flash 的编程操作请参考图

5-7。 

此外，高云半导体 FPGA 产品支持 JTAG 菊花链操作，即，把一个 FPGA

的 TDO 管脚连接到下一个 FPGA 的 TDI 管脚，Gowin 编程软件会自动识别

连接在一起的 FPGA 器件，依次进行配置。菊花链配置的连接示意图如图 5-3

所示。 

图 5-3 菊花链配置模式连接示意图 
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                       TDO
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                       TDI
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5.3 自启动配置 
注！ 

关于自启动配置时序图及相关时序参数说明请分别参考《GW1N(R)系列 FPGA 产品编程配

置手册》及《GW2A(R)系列 FPGA 产品编程配置手册》中 5 配置模式介绍。 

自启动配置模式，即 AUTO BOOT 配置模式，是高云半导体针对

GW1N(R)系列非易失 FPGA 产品的瞬时接通特性推出的一种配置模式，

GW2A(R)系列 FPGA 产品不支持自启动配置模式。自启动模式下，芯片上

电后无需连接外部配置接口，FPGA 即可自行从内置 Flash 读取比特流数据

完成配置。 

用户使用自启动模式时，首先需要通过 JTAG 接口将配置数据编程到

FPGA 的内置 Flash 中（参考 JTAG 配置模式连接示意图，图 5-2），然后调

节 MODE 值为“000”，当系统重新上电或低电平脉冲触发 RECONFIG_N

管脚时，芯片会自动读取比特流数据完成配置过程。用户将 MODE 值设置为

“000”，使用 Gowin 编程软件编程内置 Flash 结束后 FPGA 会自动配置

SRAM 完成自启动。内置 Flash 的瞬时接通特性为配置过程节约了下载时间，

提高了工作效率。 

相比于 GW1N(R)系列的其他 FPGA 产品上电后只能支持一次自启动配

置操作，GW1N(R)-6 和 GW1N(R)-9 FPGA 支持重试两次自启动配置，即，

上电后自启动配置失败时，器件可以自动进行两次重新配置操作。导致配置

失败的因素包括 ID 验证错误，CRC 校验错误和指令错误。 

注！ 

内置 Flash 中只能保存一份比特流数据，配置重试地址无法修改。 
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5.4 SSPI 配置模式 
注！ 

关于 SSPI 配置时序图及相关时序参数说明请分别参考《GW1N(R)系列 FPGA 产品编程配
置手册》及《GW2A(R)系列 FPGA 产品编程配置手册》中 5 配置模式介绍。 

SSPI（Slave SPI）配置模式，即 FPGA 作为从器件，由外部 Host 通过

SPI 接口对高云半导体 FPGA 产品进行配置的过程。SSPI 模式相关的配置

管脚如表 5-3 所示。 

表 5-3 SSPI 配置模式管脚 

管脚名称 I/O 类型 说明 

RECONFIG_N 
I, 

内部弱上拉 
低电平脉冲：启动 GowinCONFIG 配置 

READY I/O 
高电平：当前可以对 FPGA 进行编程配置 

低电平：禁止对 FPGA 进行编程配置 

DONE I/O 
高电平：成功完成编程配置 

低电平：未完成编程配置或编程配置失败 

MODE[2:0] 
I, 

内部弱上拉 
配置模式选择，READY 上升沿采样 

SCLK I 输入时钟 

CLKHOLD_N 
I, 

内部弱上拉 

高电平：SCLK 对应的 SPI 操作有效 

低电平：SCLK 对应的 SPI 操作无效 

SO O FPGA 输出数据到 Host 

SI I Host 向 FPGA 输入数据 

SSPI_CS_N 
I, 

内部弱上拉 
SSPI 片选信号，低电平有效 

 

使用 SSPI 配置模式对高云半导体 FPGA 产品配置的连接示意图如图

5-4 所示。 

图 5-4 SSPI 配置模式连接示意图 

FPGA
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CLK_HOLDN

SSPI_CS_N

Host

CLK

DIN

DOUT

CTRL

CS_N

 

注！ 

此图为 SSPI 配置模式的最小系统图，SSPI 模式 MODE 值为“001”，其他固定管脚的接

法请参考图 5-1。 

SSPI 配置管脚除了进行常规的 SRAM 配置操作外，还可编程 FPGA 外

部的 SPI Flash，编程 Flash 操作的 MODE 值与 SSPI 配置模式的 MODE 值

相同，用户可以在 Gowin 编程软件中选择将配置数据写入 SRAM 或外部

Flash。SSPI 接口编程外部 Flash 的连接示意图如图 5-5 所示。 
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图 5-5 SSPI 编程外部 Flash 连接示意图 

FPGA

                                        

CLKHOLD_N

SCLK                   MCLK

SSPI_CS_N      MCS_N

SI                               MI

SO                            MO

Host

 CTRL     
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Flash

CLK

CS_N
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注！ 

目前仅 GW1N(R)-6 和 GW1N(R)-9 器件支持 SSPI 编程外部 Flash。 

5.5 MSPI 配置模式 
注！ 

关于 MSPI 配置时序图及相关时序参数说明请分别参考《GW1N(R)系列 FPGA 产品编程配

置手册》及《GW2A(R)系列 FPGA 产品编程配置手册》中 5 配置模式介绍。 

MSPI（Master SPI）配置模式，即 FPGA 作为主器件，通过 SPI 接口

主动从外部 Flash 读取比特流数据完成配置的过程。MSPI 配置过程： 

1. 将 MODE 管脚设置为编程外部 Flash 状态，将 FPGA 重新上电或低电平

脉冲触发 RECONFIG_N，通过 JTAG 接口将配置数据编程到外部 Flash

器件中； 

2. 将 MODE 管脚设置为 MSPI 状态，低电平脉冲触发 RECONFIG_N 或者

重新上电，器件自行从外部 Flash 读取比特流数据，完成配置过程。 

根据 MSPI 的配置特性，用户可以实现远程升级的需求：当 FPGA 启动

工作后，若有升级需求，用户可以将配置数据远程写入 FPGA 外部的 Flash

器件中，当具备升级条件时触发 RECONFIG_N 或重新上电使系统完成升级。 

注！ 

MSPI 配置模式通常需要设置两种 MODE 值（编程外部 Flash 和从 Flash 读取数据），用户

进行原理图设计时需要预留 MODE 值的切换功能；MODE 值不方便切换时，也可固定为

MSPI 模式，使用边界扫描操作编程外部 Flash，具体方法请参考 7 边界扫描操作。 
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MSPI 模式相关的配置管脚如表 5-4 所示。 

表 5-4 MSPI 配置模式管脚定义 

管脚名称 I/O 类型 说明 

RECONFIG_N 
I, 

内部弱上拉 
低电平脉冲：启动 GowinCONFIG 配置 

READY I/O 
高电平：当前可以对器件进行编程配置 

低电平：禁止对器件进行编程配置 

DONE I/O 
高电平：成功完成编程配置 

低电平：未完成编程配置或编程配置失败 

MODE[2:0] 
I, 

内部弱上拉 
MODE 选择信号，READY 上升沿采样 

MCLK O FPGA 输出时钟 

MCS_N O 片选信号，低电平有效 

MO O FPGA 输出数据到 Slave 

MI I Slave 输入数据到 FPGA 

FASTRD_N I 

READY 信号上升沿采样 

高电平：普通 Flash 访问模式（采用 Flash 读指令 0x03）

低电平：高速 Flash 访问模式（采用 Flash 读指令 0x0B） 

注！ 

MSPI 配置模式时钟频率不能大于 80MHz，当时钟频率大于 30MHz 时需要使用 Flash 的高

速访问模式并外部拉低 FASTRD_N 管脚。时钟频率不高于 30MHz 时，FASTRD_N 管脚悬

空即可。 
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使用 MSPI 配置模式对高云半导体 FPGA 产品进行配置的连接示意图如

图 5-6 所示。 
图 5-6 MSPI 配置模式连接示意图 

FPGA

                       

                               

 FASTRD_N

                                MCLK

                             MCS_N

                                     MI

                                    MO

SPI Flash

CLK

CS_N

DOUT

DIN
 

注！ 

此图为 MSPI 配置模式的最小系统图，MSPI 模式 MODE 值 GW1N(R)为“010”，GW2A(R)

为“000”，其他固定管脚的接法请参考图 5-1。MSPI 配置模式时钟频率不高于 30MHz 时

FAST_RD 管脚可悬空。 

通过 JTAG 接口把配置数据编程到外部 Flash 器件中的连接示意图如图

5-7 所示，通过 JTAG 接口编程外部 Flash 需要设置特定的 MODE 值，请参

考相关器件的编程配置手册。通过 SSPI 接口编程外部 Flash 的连接示意图

请参考图 5-5。 
图 5-7 JTAG 接口编程外部 Flash 的连接示意图 

FPGA

                     

TDI                       MCLK

TCK                   MCS_N

TMS                           MI

TDO                         MO

JTAG PORT

Flash

CLK

CS_N

DOUT

DIN

4
.7

K

 
注！ 

此图为 JTAG 接口编程外部 Flash 的最小系统图，MODE 值设置为“011”（边界扫描操作

编程外部 Flash 不必关心 MODE 值），其他固定管脚的接法请参考图 5-1。 

高云半导体 FPGA 产品通常上电之后只支持一次自动的 MSPI 配置操作，

GW1N(R)-6 和 GW1N(R)-9 和 GW2A(R)-18 系列产品在此方面进行了增强

处理：GW2A(R)-18 系列 FPGA 支持重试一次配置操作；GW1N(R)-6 和

GW1N(R)-9 FPGA 支持重试两次配置操作。上电后 MSPI 配置失败时，器件

可以按照支持的重试次数自动进行重新配置操作。导致配置失败的因素包括
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ID 验证错误，CRC 校验错误和指令错误。用户可以指定重试配置操作的 SPI 

Flash 地址，通过 Gowin 云源软件界面写入。这一特性大大降低了配置失败

的风险，为用户设计提供了更高的可靠性保障。 

多重配置（MULTI BOOT）是 MSPI 配置模式的衍生概念，是指 FPGA

从同一片外部 Flash 的不同地址读取比特流数据进行配置的过程。目前

Programmer 软件支持在不擦除的情况下将多个比特流数据依次编程到外部

Flash 中，初始编程地址为 0。用户在前一个比特流数据中写入后一次配置的

比特流数据的加载地址，在器件不掉电的情况下通过触发 RECONFIG_N 切

换数据流文件完成配置。支持 MSPI 配置模式的 FPGA 产品均支持此模式。 

注！ 

 [1]多重配置需要在不掉电的情况下触发 RECONFIG_N 进行配置数据切换，器件掉电

后启动地址清零； 

 [2]用户使用多重配置前需计算好比特流数据的大小，确保启动地址不会被前一个比特

流数据所覆盖； 

 [3]SPI Flash 启动地址低 12 位无效，用户可设置的是 ADDR[23:12]的地址空间。 

除了上述介绍的一片Flash配置一片FPGA的情形，高云半导体的FPGA

产品也支持一片 Flash 配置多片 FPGA 的情况：与 SPI Flash 直接相连的

FPGA 器件采用 MSPI 配置模式，其他 FPGA 采用 SSPI 或 SERIAL 配置模

式。具体的操作方案后续版本会进行更新。连线示意图如图 5-8 所示。 

注! 

配置操作前需要将相关 FPGA 的 MODE 值调整为 MSPI 和 SERIAL 配置模式或者是 MSPI

和 SSPI 配置模式。高云半导体的 FPGA 产品尚不支持多片 Flash 配置同一片 FPGA 的情

况。 

图 5-8 一片 Flash 配置多片 FPGA 连接示意图 

TBD 
 

5.6 双启动配置 

双启动配置模式，即 DUAL BOOT 配置模式，是高云半导体 GW1N(R)

系列非易失 FPGA 产品支持的一种配置模式。双启动配置模式下，FPGA 自

主选择从内置 Flash 或者外部 Flash 读取比特流数据完成配置。双启动配置

模式需要选择特定的 MODE 值，从内置 Flash 启动无须外部连线，从外部

Flash 启动的连线方案与 MSPI 配置模式相同，请参考图 5-6。双启动配置模

式提供了更多的配置路径选择，用户可以按照自身需求选择配置数据的存储

位置。 

GW1N(R)系列 FPGA 支持两种方式的双启动配置模式：GW1N-1，

GW1N(R)-6 和 GW1N(R)-9 器件 MODE 值为“100”时，优先选择从内置

Flash 启动，当内置 Flash 配置失败时，器件读取外部 Flash 的数据进行配

置；当内置 Flash 为空时，器件不进行配置操作。除此之外，GW1N(R)-6

和 GW1N(R)-9 器件支持 MODE 值为“110”时，器件优先选择从外部 Flash

启动，当外部 Flash 配置失败时，器件再选择读取内置 Flash 的数据进行配

置；外部 Flash 为空时，器件不进行配置操作。双启动配置模式的流程如图

5-9 所示。 
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图 5-9 双启动配置模式流程图 
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注！ 

此图为 MODE 值为“100”时双启动配置的流程图。MODE 值设置为“110”时 FPGA 优

先选择从外部 Flash 启动。 

对于 GW1N(R)-6 和 GW1N(R)-9 系列产品，无论是哪种模式的双启动

配置，FPGA 均支持 4 次配置尝试：优先选择的存储路径启动 3 次，3 次均

失败后选择另一个路径进行配置。内置 Flash 的启动只能开始于 0 地址；

MODE 值为“110”时，从外部 Flash 启动的 3 次尝试可以选择不同的启动

地址，启动地址需要预先通过云源软件写入比特流数据，当外部的 3 次配置

尝试都失败时器件选择从内置 Flash 启动。 

注！ 

SPI Flash 启动地址低 12 位无效，用户可设置的是 ADDR[23:12]的地址空间。 

GW1N(R)-2 和 GW1N(R)-4 器件目前尚不支持器件自动的双启动配置，

高云半导体为用户提供了这两款器件的双启动配置方案，详细信息请参考手

册《基于高云半导体 GW1N-4 芯片的 DUAL BOOT 下载方案》。 

 

5.7 CPU 配置模式 

CPU 配置模式下，Host 通过 8-bit 位宽的数据总线接口对高云半导体

FPGA 产品进行配置，CPU 配置模式的管脚如表 5-5 所示。 
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表 5-5 CPU 配置模式管脚 

管脚名称 I/O 类型 说明 

RECONFIG_N 
I，内部弱上

拉 
低电平脉冲：启动 GowinCONFIG 配置 

READY I/O 
高电平：当前可以对器件进行编程配置 

低电平：禁止对器件进行编程配置 

DONE I/O 
高电平：成功完成编程配置 

低电平：未完成编程配置或编程配置失败 

MODE[2:0] 
I，内部弱上

拉 
配置模式选择信号，READY 上升沿采样 

SCLK I 输入时钟 

CLKHOLD_N 
I，内部弱上

拉 

高电平：CPU 操作有效 

低电平：CPU 操作无效 

WE_N I 

读写使能 

0：写 

1：读 

D[7:0] I/O 
数据输入输出端口：CPU 配置模式时作为输入管

脚，配置结束后可以转换为输出管脚进行验证 

 

CPU 配置模式的连接示意图如图 5-10 所示。 
图 5-10 CPU 配置模式连接示意图 

8

FPGA
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WE_N

CLK_HOLDN

Host

CLK

DATA

WE_N

CTRL

 
注！ 

此图为 CPU 配置模式的最小系统图，MODE 值设置为“111”，其他固定管脚的接法请参考

图 5-1。 

5.8 SERIAL 配置模式 

SERIAL 配置模式，Host 通过串行接口对高云半导体 FPGA 产品进行配

置。SERIAL 配置模式是使用管脚数量最少的配置模式。SERIAL 配置模式

只能将比特流数据写入 FPGA，无法从 FPGA 器件回读数据，因此，SERIAL

配置模式无法读取 ID CODE 和 USER CODE 以及状态寄存器信息。SERIAL

配置模式的管脚定义如表 5-6 所示。 



5 配置模式介绍 5.8SERIAL 配置模式 

 

UG290-1.02 31(34) 

 

表 5-6 SERIAL 配置模式管脚定义 

管脚名称 I/O 类型 说明 

RECONFIG_N 
I,内部弱上

拉 
低电平脉冲：启动 GowinCONFIG 配置 

READY I/O 
高电平：当前可以对器件进行编程配置 

低电平：禁止对器件进行编程配置 

DONE I/O 
高电平：成功完成编程配置 

低电平：未完成编程配置或编程配置失败 

MODE[2:0] 
I,内部弱上

拉 
配置模式选择信号，READY 上升沿采样 

SCLK I 输入时钟 

DIN 
I,内部弱上

拉 
输入数据 

DOUT O 输出数据，只用于 FPGA 级联时 SERIAL 配置模式 

 

SERIAL 配置模式的连接示意图如图 5-11 所示。 

图 5-11 SERIAL 配置模式连接示意图 
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Host

CLK

DOUT

 
注！ 

此图为 SERIAL 配置模式的最小系统图，MODE 值为“101”，其他固定管脚的接法请参考

图 5-1。 
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6SPI Flash 选择 

高云半导体 FPGA 产品支持的外部 SPI Flash 器件操作指令如表 6-1 所

示，市场上常见的 Mxic 和 Winbond 的产品均符合要求。 

表 6-1 SPI Flash 操作指令 

操作 指令 

bulk_erase C7 

page_program 02 

read 03 

fast_read 0B 

write_enable 06 

write_disable 04 

注！ 

高云半导体 FPGA 支持的 Flash 读指令必须至少有一种是 03 或 0B，当时钟频率不高于

30MHz 时使用普通读指令；当时钟频率高于 30MHz 时，使用快速读指令，快速读取需要将

FASTRD_N 管脚拉低，时钟频率不能高于 80MHz。 
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7边界扫描操作 

边界扫描操作是 JTAG 配置模式的扩展，扫描链分为长链和短链：长链

主要结合 BSDL 文件进行器件的测试工作；短链主要针对 FPGA 链上的外部

Flash 进行擦除和读写操作。 

边界扫描操作步骤如下： 

1. 将 FPGA 开发板连接到 PC 并上电； 

2. 打开 Gowin 编程软件扫描已连接的器件； 

3. 在 Operation 下方双击选择外部 Flash 操作，并选择相关的 bscan 操作，

如图 7-1 所示。 
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图 7-1 边界扫描操作示意图 

 
 

边界扫描操作只能对 FPGA 外部 Flash 进行操作，无法对内置 Flash 或

SRAM 进行编程配置。边界扫描操作编程外部 Flash 时不必关心 FPGA 

MODE 值的设置，但是相比于 MSPI 操作中编程外部 Flash 的方法，边界扫

描操作的编程速度较慢。 



 

 

  

 

 

 

 

 

 

 

 

 

 

 

 

 

 
 


	免责声明
	版本信息
	目录
	图目录
	表目录
	1 关于本手册
	1.1 手册内容
	1.2 适用产品
	1.3 相关文档
	1.4 术语、缩略语
	1.5 技术支持与反馈

	2 名词解释
	3 配置管脚介绍
	3.1 配置管脚列表及复用选项
	3.1.1 配置管脚列表
	3.1.2 配置管脚复用

	3.2 配置管脚功能及应用

	4 比特流文件
	4.1 配置数据加密
	4.2 配置文件大小
	4.3 配置选项设置

	5 配置模式介绍
	5.1 配置须知
	5.2 JTAG配置
	5.3 自启动配置
	5.4 SSPI配置模式
	5.5 MSPI配置模式
	5.6 双启动配置
	5.7 CPU配置模式
	5.8 SERIAL配置模式

	6 SPI Flash选择
	7 边界扫描操作

